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1. Overview
"DynaDoctor for VRF" analyses data sent from the Dynakit, and supports the status display of outdoor

and indoor units. This tool can be used to check refrigerant cycle data, display various data graphs,
execute indoor unit test runs and create reports of test run results.

Furthermore, received data can be saved and browsed, and secondary use of data can be carried out

easily.

2. Operating Environment
The following is the ideal operating environment for this software:

Item Specifications
PC Windows 7 Windows 8.1 Windows 10 compliant
Operating System Windows 7 Windows 8.1 Windows 10 compliant
Microsoft Excel Excel 2003 or later
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3. DynaDoctor for VRF basic operation
3.1. DynaDoctor for VRF functions
3.1.1. Check refrigerant cycle data

A refrigerant cycle data check can be performed using DynaDoctor for VRF. This function allows for
visual checking of the status of outdoor and indoor units.
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Figure 3.1.1
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3.1.2. Save/browse data
Data communicated by the Dynakit can be saved. Furthermore, this saved data can be used to check

past data.
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Figure 3.1.2
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3.1.3. Display data graphs
Data graphs for indoor and outdoor units can be displayed using saved data. Viewing several graphs

together makes it easy to compare data.
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3.1.4. Air conditioner test runs
Test runs can be executed on connected indoor units. Furthermore, received data can be used to create
reports of test run results.
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3.2. Starting/exiting DynaDoctor for VRF
3.2.1. Start-up DynaDoctor
DynaDoctor for VRF can be started up in 2 ways, using a desktop shortcut or the Windows menu.
@ Start-up DynaDoctor
Using a desktop shortcut
Double-click the desktop shortcut.

Using the Windows menu
In the [Start] menu, select [All Programs] > [Toshiba] > [DynaDoctor for VRF] > [DynaDoctor for

VRF].

@ When DynaDoctor for VRF has started-up
The DynaDoctor for VRF main menu screen is displayed when DynaDoctor for VRF has started-up.

The functions can now be used.
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Figure 3.2.1
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3.2.2.  Exiting DynaDoctor for VRF
Click the [Cancel] button to exit DynaDoctor for VRF.
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Figure 3.2.2
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4. Using DynaDoctor for VRF

DynaDoctor for VRF uses an MDI window. Each window is displayed inside the MDI window.

4.1. Displaying data
Choose the button for the connected model from the [Outdoor unit] group box.

==
Dyna Doctor for VRF rT1on
Outdoor unit group box N Outdoce Lyt [
M) SMMS o
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Repoet for Test
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Figure 4.1.1

The MDI parent window opens. If the communication function is unavailable, a message is displayed.

Choose [Yes] to open the window. Choose [No] to return to the main menu.
SMMS-i DYMA-DOCTOR 23

o -"-I Communication function not available.
y' Browsethe already saved data?

Figure 4.1.2

When communication is possible, or when browsing data, a wait screen is displayed while the screen

renders.
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When the screen has been rendered, a system configuration diagram window opens.
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4.2. Saving received data

To save communication data, select [Save...] from the [File] menu. A save window opens.
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Print.
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Figure 4.2.1

To choose the save destination, click the [Browse] button. A save file dialogue is displayed. Choose a
save destination. The destination file path is displayed in the window.

Change the [Data Sampling Time] to alter the frequency with which data is saved to the file. Comments
can also be added to files.

2 SanData @ a Browse button
[ Pile Name ] I [C: 005120301106 _A Ver.0.0,1.9.09 I Browse
[ Comment ] k
[ D#ta Sanpling Time | I ]G'xf :]I File Name
[Date] ¥ . Decessar 10, v ]
[OstaComnt ] oK | Loncet J
Please seloct the Dyna Doctor save folder sed file,

_J

Data sampling time Figure 4.2.2

Click the [OK] button to start saving data to the file.

£ S Data =52
[ Pile Name ] [C: 005120301106 _A Ver.0.0.1.9.m8 Browse
[ Comment ]
[ O#ta Sampling Time ) 0lsec Y
[Date | Monday |, Decester 10, -l
[Oata Comt ] oK Loncet J
Please select the Dyna Doctor save folder sad fike,

Figure 4.2.3 \_

OK button
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4.3. Browsing saved data

Data saved in Saving received data can be browsed. To browse data, choose [Browse...] from the [File]

menu. A file browsing window opens.
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Save.
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Edit...
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Figure 4.3.1
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Click the [Refer to] button to select which data to browse. An open file dialogue is displayed. Select a file.

The destination file path, save date and data count are displayed on the screen. If there are any

comments attached to the file, they are also displayed.

Refer to button

#.. Dana Reference =
[ Fre Name 1 Iﬁ:.'{)OF..‘OlGl::n‘,A Ver.0.0.1.9.0 I Beferto II
[ Comment ] '\ e
Data Count x , \ -
o = File Name
[Data ] [ p—
[ Daota Coant | I oK ] Cancel ]
Please sedpct the Dyna Doctor data,
Figure 4.3.2
Click the [OK] button to start browsing the file.
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[Date ) [ Norde — _l
[Dota Coant § o I oK I Cancs! J
Please sedact the Dyna Docter data, \

Figure 4.3.3
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When browsing files, [Record No.], a scroll bar, [Time] (time elapsed since the first piece of data was

saved) and [Date & Time] (time that data was received) are displayed.

Time that data
was received
/S Record No.
e s
Ete Coomect JFefCycle Graph Menu LUnt  Window Zcton  Heb
42 System Congfuration Diagram ¥ e e e
Iﬂbcnnﬂh ] || L_II Tee ‘:' 00 min I Date&Time | 10544 PN
Systen Corfiger aon Dlagram (Conmunication) | Syupters ConBi% aton Dy am (Refrigeration Croe) | Feferaton Cycie Ovgran (System Dets) |
Figure 4.3.4
Scroll bar Tlme elapsed since the first
piece of data was saved

Move the scroll bar to change the data being displayed. A number can also be entered directly into

Record No. to change the displayed data.

4.4. Editing data files

File comments saved in Saving received data can be edited. To edit comments choose [Edit...] from the

[File] menu. A file edit window opens.

#.] SMMS-i DYNA-DOCTOR
Eile | Connect  Ref.Cycl
1 Save.. N
Browsze...
| Edit.. |

Set up..,
Print...

Exit

Figure 4.4.1
Click the [Renewal] button to select which data to edit. An open file dialogue is displayed. Select a file.

The destination file path, save date and data count are displayed on the screen. If there are any

comments attached to the file, they are also displayed.
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Renewal button

[ Pile Name ] I| I Renesal II
[ Comment ] ‘ L
Data Count - - \ -

' = 2] File Name

[Dae ] ooty .+ Doconber 10,

[ Cata Cownt ] [ I Concet |
Select a File Name andd Press The [Renewal| Button

Figure 4.4.2
Click the [OK] button to save the edited comments.

File Edit

[ File bame ] [ Renewal

[ Comment |

[ Dzt Sampling Time ] |-:-]5a-: j

[Date] [ Monday ., December 10, ~]

[ Dt Cownt ] | I a I Cancal |
Select a File Mame and Press The [Renewal] Button. \

Figure 4.4.3

4.5. Communication settings

OK button

Communication settings can be changed. To open the communication settings window, select [Set up...]

from the [File] menu.

Figure 4.5.1

The COM port on the computer which is running the system is displayed in [Port Setting]. To change the

COM port used for the connection, select a COM port from the list. Press the [Set] button to change the

COM port.
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s =
—Part Setting
! =]

foowz |

I 10ay. - Port Setting
,iet Cancel |
/
Set button J Figure 4.5.2

4.6. Printing out the screen
The displayed screen can be printed out. To open the print settings window, select [Print...] from the [File]

menu.

. SMMS-i DYNA-DOCTOR

Connect  RefCycle G

Save..

Browse...

Edit...

Set up...

Print...

Exit

Figure 4.6.1

Click the [Property] button to change the printer settings. A print dialogue is displayed. The number of

copies can also be input directly.

Print o]
—Prinber
Wame: Microsoft XPS Domment Wiiter
W
[ — | Property button
IEupiE 13: I
e * | o |
No. of copies | —— Figure 4.6.2
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Figure 4.6.3

Click the [OK] button to print out the screen.

4.7. Finishing communicating/browsing

To finish communicating with the outdoor unit or browsing a data file, select [Select Type...] from the
[Connect] menu.

. SMMS-i DYNA-DOCTOR
File | Connect | Ref.Cycle G

Select Type...

Figure 4.7.1

Afinish confirmation message is displayed. Click [OK] to end communication/browsing and go to the main
menu.

-

SMMS-i DYNA-DOCTOR [

. etting change [objective machine]
-_l_}. Program will be initialized. If any data is being saved,
it will be lost. Are you sure?

Cancel |

Figure 4.7.2
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4.8. Managing the windows
Use the [Window] menu to manage the open windows.

Window | Action Help
Tile
Cascade

1 System Configuration Diagram

Figure 4.8.1

4.8.1. Displaying windows side by side
Choose [Tile] from the [Window] menu to display windows side by side. The open windows are
automatically lined up and positioned.

Window | Action Help

| Tie |
Cascade

1 System Configuration Diagram

Figure 4.8.2
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4.8.2. Displaying windows in a cascade

Choose [Cascade] from the [Window] menu to display windows in a cascade. The open windows are
automatically stacked and positioned.

Figure 4.8.4
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Figure 4.8.5
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4.8.3. Displaying a specific window at the front
To display a specific window at the front, select the appropriate window from the [Window] menu. The
selected window is displayed at the front.

3Outdoor Gresh
[] 45ysteen contret data titse

Figure 4.8.6
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Figure 4.8.7
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5. Refrigerant cycle diagrams
5.1. Displaying a system configuration diagram (communication)
A system configuration diagram for the air conditioner currently connected or being browsed can be

displayed. To display a system configuration diagram, select [System Diag] from the [Ref. Cycle] menu.

-DOCTOR

Bef.Cycle | Graph Menu  Unit Wi
| Systemn Diag
Ref.Cycle Diag. - System Data

List Data - 5ystem Data

Figure 5.1.1

Await screen is displayed while data is loading. The system configuration diagram is displayed when data
has finished loading.

The system configuration diagram can be used to check the indoor/outdoor unit connection or operation
status.

(& i e g =T
Record Mo oel] s Tem 00 my  DetyATre | 95339 A
[ Evsion Cordiguranon Dagram Formuncaton) | Sysien Confiouoson Diegran Refrgesaton Cvde) | Rebigerasn Crde Dagras Systery Data) |
3 J J
SHGEONY b s [ st [ tomana [~

4 NS N J »

[F_::Wl_ﬁ-ch [T Bt [ T e

1 2 3 4 2 8 7 & » 10
WDt Coust 3oy pa— oy ey F— Sonwy - mey
84 &0 LR a 17 40 10 1) 20 an -
Teetwa OFF | buut 01 *aat O vesl UM Haw D Thero OFF | Therrs OFF  {Hasi 00 Heut 0 st OH
2Ny 2y
LE] 1y =
™

« 0¥ Moot 0N

-

[P l 7
[ con, et

Figure 5.1.2
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5.2. Displaying a system configuration diagram (refrigerant cycle)
The refrigerant cycle for the air conditioner currently connected or being browsed can be displayed. Refer

to Displaying a system configuration diagram (communication) or Displaying a refrigerant cycle diagram

(system data) for information on displaying the refrigerant cycle window.

Click the [System Configuration Diagram (Refrigeration Cycle)] tab in the system configuration diagram

window to display a refrigerant cycle diagram for the whole system.

E e - =ToRE|
Record Mo ol 3 e G0 my  DeteATre | 95339 A

Sysiom Conigursoon g (Commescanon) | Svsien Corlguroson Dagram Fefrgeraton Cyde] | Retgerasn Croe Dagraw (Systery Data)

Figure 5.2.1

Click the [Switch] button to switch between displaying the refrigerant cycle diagram data item and the
actual data. Move the [Indoor unit] scroll bar to change the indoor units being displayed (five units at a
time).
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Figure 5.2.2

5.3. Displaying a refrigerant cycle diagram (system data)

A refrigerant cycle diagram for each air conditioner currently connected or being browsed can be

displayed. To display the refrigerant cycle diagram screen, select [Ref. Cycle Diag. - System Data] from
the [Ref. Cycle] menu.

-‘DOCTOR
Ref.Cycle

Graph  Menu  Unit Wil
System Diag

Ref.Cycle Diag. - System Data
List Data - Systern Data

Figure 5.3.1

Await screen is displayed while data is loading. The system configuration diagram is displayed when data
has finished loading.

The refrigerant cycle for each indoor/outdoor unit can be checked individually on the refrigerant cycle
diagram screen.
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Click the [Switch] button to change the display mode. The display modes are [Automatic] and [Fixed]. In

[Automatic] mode the indoor unit changes once a second. In [Fixed] mode the unit being viewed can be
changed using the [Indoor unit] scroll bar.

Switch button

Indoor unit scroll bar
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The outdoor unit being displayed can also be changed. Click the [Header], [Follower 1], and [Follower 2]
buttons to choose an outdoor unit to be displayed.
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Figure 5.3.4

5.4. Displaying list data/system data

Alist of system data can be displayed. To open the system data table window, select [List Data - System
Data] from the [Ref. Cycle] menu.

Rf.Cyde Greph Menu Unt Wa
System Diag
Ref.Cycle Ciag. - Systam Datz
List Dzta - System Data |

Figure 5.4.1
A wait screen is displayed while data is loading. The system data table window is displayed when data

has finished loading.

The system data table window can be used to check the status of outdoor/indoor units in a table format.
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Click [View 1] or [View 2] to switch between the data being displayed.
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6. Displaying graphs
Data can be displayed in graph form. Graphs can be displayed when browsing data files.

6.1. Displaying outdoor unit graphs
Outdoor unit data can be displayed in graph form. To open the outdoor unit graph item selection window,
select [Outdoor Unit - System Data] from the [Graph] menu.

Iﬁmph Mene  Unit Window &
Incoor Urst

Ice Regenerator

Figure 6.1.1

The items to be displayed on the graph can be chosen in the outdoor unit graph item selection window. A

maximum of 6 items can be displayed on the graphs.

Check Header unit Check: Folower 1uvt ek Folower 2Junt Check Folower 31t
™ |Comp Hz I |CGorpte ™ [Comphs (gl T

[T |Pressue sensor I~ |Pressue senser I [Pressure sereor I~ presure s

™ |78 serer ™ |7d seser ™ [T senser |l

[T |aeam/to weeo ™ |10 sensor I [TELMEINIYO sensor © e mto seeer
I |75 senser I~ [7ssensor I [Tssersor T |rssensce

[ PMvi/2open rase 7 [Py 2 open tate [T |12 cpen rato [T P2 ooen rese
[T |Pv4cpenrato I™ |PMv4 openratio I [PMv4ccenrato [T Prrvdcpenrane

[T | Sassse I™ [V Si 250550 I |9 NaveSVISVSSVE ™ |wyeiiamsss
I mL2s4s I~ Im12348 I~ [meL2aas [l SR AT

[T outdoor Fan mode ™ [Cutdoor Fan mede I~ |outdoor Fan mode [T Joutdoor Fan mode
[T |indosr woret

Figure 6.1.2
Select the desired item and click the [OK] button to display a graph. When the [OK] button is clicked, a

wait screen is displayed while graphs are rendered. When graphs are rendered the graph display window

opens.
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6.2. Displaying indoor unit graphs
Indoor unit data can be displayed in graph form. To open the indoor unit graph item selection window,
select [Indoor Unit] from the [Graph] menu.

Menu  Unit  Window A
Butdoor Unit - Systern Data
Indoor Unit

Ice Regenerator

Figure 6.2.1

The items to be displayed on the graph can be selected in the indoor unit graph item selection window. A
maximum of 20 indoor units can be selected. [Cycle Data] and [Control Data] can be selected when 1 unit
is chosen. [Indoor Comparison Data] can be selected when 1 or more units are chosen.

[Cycle Data]/[Control Data] and [Indoor Comparison Data] cannot be selected at the same time.
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Figure 6.2.2
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6.2.1. Displaying individual indoor unit graphs
To display graphs for individual indoor units, select 1 indoor unit and cycle data/control data. Then click
[OK]. When the [OK] button is clicked, the wait screen is displayed while graphs are rendered. When

graphs are rendered the graph display window opens.
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6.2.2. Displaying [PMV Opening, Status] comparison graphs for indoor units
To display [PMV Opening, Status] comparison graphs for indoor units, select 1 or more indoor units and
[PMV Opening, Status]. Then click [OK]. When the [OK] button is clicked, the wait screen is displayed

while graphs are rendered. When graphs are rendered the graph display window opens.
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6.2.3.  Displaying [Suction Temperature, Relative Ability] comparison graphs for indoor units

To display [Suction Temperature, Relative Ability] comparison graphs for indoor units, select 1 or more
indoor units and [Suction Temperature, Relative Ability]. Then click [OK]. When the [OK] button is clicked,
the wait screen is displayed while graphs are rendered. When graphs are rendered the graph display

window opens.

e o Jiodsor ] Frenae L= fonac Graph Cartents 41
(S T (1) Woered I joyde Da
r |2 |58 Fresh (13 POV Coeng
I 3 w2 Frent, { ‘
AT H
% & lea resh II;TA,‘ /':cxﬁc "}
L O Foush 17) Outdoar unk pressure |
¥ o |52 Horral |Erton teTpesue
v |7 |32 Mool " lcosesl tota |
P s |52 Fress
rlo | Frah (1) Casacty Raqurement
> 2) Operaton Wode
r s |40 Frest 13) Igoec Fan ‘
U S (Y Fresh
212 Freat, [ {indeor Comparean Dot (1) |
<PMY Ogerng, Satus>
Indoor Compareon Outa {2) ‘
P |«Sactien temperature, Rastve
ey > i
Select A Rese &1 | g | [y |

Figure 6.2.7

M

Fascard o eI o] T 00 w0 OmedTwe EGETY
Temapeae fods 5 RO O A
Casocty’ W 4 W W N0 |MefTes I 13 0 2 M % B Y W

-

woe | =

i | MU %3

w. % oors ars

LN 0.0% B3

e | eI W At
= = L

Figure 6.2.8

33/67



TOSHIBA
o

Historical data can be used for [Suction Temperature, Relative Ability] comparison graphs. Refer to
Browsing saved data for more information about using historical data.
Move the scroll bar to change the indoor unit display. The temperature scale can also be changed.
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7. Other functions
7.1. Checking the list of check codes

Select [List Check Codes] from the [Menu] menu. The list of check codes window opens.

Menu | Unit  Window  Actic

| List Check Codes |
System data List

Sensor Data

Control Beplanation
Troubleshoot

Compress Data

Combine Data

Figure 7.1.1

Choose a check code to display detailed information about it.

| Chack cods | Datecting Operatng Ekmsnt - Detaled Information

! of 3000 Smor batwean ngop Check Code (BN
E02 Remote contr Sanding error of remote controber Operng | Coovaninication Eeves betwees o s resmote
E03 Indoer Cormmunication esror between ndoot and reme Hamert | controler{Detected at remote controler sde)
ED4 Indoor Indoor/outdoor communication crcuk emor (De ™ = R 3 5
E06 F Decreass of ndoor unts ! mmw oy
£07 3 Indoor/outdoor communcation crcuk aror {Ds Dﬂumﬂc
€08 Indoor UF Dupbcated ndoor addresses
E09 Remote contr Dupkcated mam remote controlers |
E10 2Indoor Commmmunicztion eror betwean ncoor MCU Cneck remate condroler avter unit cable (A)
E12- b3 Automatic address start amor mmw contact arrer.
£15 vF No ndoor durng autorste address Check indoor P2, board ervor.
E16-** F No. of connected ndoor unks / Capacky over | Check remcte convroer address setup, (When
£18 Indoor Corrrmnmxfn estor between ndoor header & ;&wmﬁm
E19-** IF Outdoor header unt guantty emor Cheek
E20-" ¥ Connecton of other Ine durng automatic addn Cortents
E23 VF Communication sendng eror between outdoor
E25 IF Dupkcated outdoor folower address setup
E26 F Decrease of No. of connected cutdoar units
€28 v Outdoor folower unt emor
B3 1IF PDU COMMUNICENon eror =

Figure 7.1.2

7.2. Displaying a system control data table

Select [System data list] from the [Menu] menu. The system control data table window opens.
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Unit  Window  Actic
List Check Codes
System data List

Sensor Data

Centrol Bxplanation
Troubleshoot

Compress Data

Combine Data

Figure 7.2.1

In the system control data table window, system control status information being received or browsed
can be checked in table format.
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Figure 7.2.2

7.3. Changing the displayed pressure data unit
The unit used to display pressure data can be changed. To change the unit, select [Pressure unit] from the
[Unit] menu, and choose the desired unit.

Unz | Window Action  Hep

| Presrelnn =
TevperstureUnt » kglem2G
Capacity Unit » Psi
Figure 7.3.1
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When the unit is changed, the displayed pressure data is displayed using the selected unit.

7.4. Changing the displayed temperature data unit
The unit used to display temperature data can be changed. To change the unit, select [Temperature unit]

from the [Unit] menu, and choose the desired unit.

Pressure Unit 3

Temperature Unit  » =] Celsiis

Capacity Unit 3 Eshrenhsit

Figure 7.4.1

When the unit is changed, the displayed temperature data is displayed using the selected unit.

7.5. Displaying tips
The system tips display can be turned on or off. Select [Tips] from the [Help] menu to turn it on or off.

Help

Function

Tips |

Yersion

Figure 7.5.1

When Tips are turned on, system operation information is displayed in the status bar.

Heating Refering

Figure 7.5.2
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7.6. Compressing data
Select [Compress Data] from the [Menu] menu. The compress data window opens.

Menu | Unit  Window  Actic

List Check Codes
Systemn data List
Sensor Data

Control Bplanation

Troubleshoot

| Compress Data |

Combine Data

Figure 7.6.1

Use the following procedure to compress data:

Specify a folder in which to store the compressed data and a file name.

Select the folder or file which the data to be compressed is saved in.

Select the files to be compressed and click the [>>] button or drag and drop them to add them.

®» 0O

To remove selected files, select the file to be removed and click the [<<] button or drag and drop

it to remove it.

&J Compress Data [E=H Bl =X

File Tool Help

f [ LOMPresse Henam
|c:‘.st‘-,20121210.zip Browse... |

- | DD5 N r—List of Files Selected —A\
§ AZW 1 File Name \ | size | |indate Nate ‘
] Kws
] Mini-SMMS = 20101106 A ver.0.0.L9m—1f () Specify a folder/file
b N SMMS |—\Z[Jil[lilil[JS_B Ver.0.0.1.9.mis 74 =T
) SQRM B 20101106_D Ver.0.0.1.9.mis 1032090 11/5/20106
: SHRMH | B 20101209_D Ver.0.0.2.9.mis 1101810 12/9/201049
] SMMS
----- ) Documents and Settings
----- 1 MSOCache
..... ) Perflogs “— | ® Click the add button
[H-{ ] Program Files

FieMame | Size | Update Date and T... |
[£) manual.mis 930930 1/5/2011 9:58:30 AM

J <
] — | @ Click the remove button
® Select the folder/file /
Figure 7.6.2
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To split and save compressed files, click the file section setting menu and choose the size.

/’ Click the icon

Choose the size

3.5" 1457664

CD700: 700 mb
DVD+R: 4481 mb
T SR

Figure 7.6.3

® Select [Compress] from the [Tool] menu on the menu bar to perform compression.

® Select compress

&.] Compress Data

Figure 7.6.4

7.7. Combining data

Select [Combine Data] from the [Menu] menu. The combine data window opens.

Menu | Unit  Window  Actic
[l List Check Codes I
System data List
Sensor Data

Control Beplanation
Troubleshoot

Compress Data

| Combine Data |

Figure 7.7.1
Data split and saved using DynaDoctor can be combined into one consecutive file.

Use the following procedure to combine data:

@ Specify the folder and file name for the combined data file.
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Select the folder or file which the data to be combined is saved in.
Select the files to be combined and click the [>>] button or drag and drop them to add them.

To remove selected files, select the file to be removed and click the [<<] button or drag and drop

® 0O

it to remove it.

/‘ @ Specify a folder/file

#. Combine Data =N =R

File  Tool Help

l IC:\DDS‘-AZW‘,combine.ddw Browse.. I

r—List of Files Selected
A
4 &

File Name | Size | Update Date and Time |
[£ 100308_14 A.ddw 235954 3/8/2010 2:10:13PM
[£ 100316_15 A.ddw 654074 3/16/2010 3:11:04PM
B 100601_18_A.ddw 23490 6/1/2010 6:54:44 FPM
B 121207_15_A.ddw 2154 12/7/2012 3:34:27 PM

174907 40 D dd JCo 120209047 2,97 44 PM

-] Mini-SMMS
-] N_SMMS
] SHRM
i) SHRMH
‘ol ] SMMS

----- | ] Documents and Settings

----- ] MS0Cach
..... i Poftas M— | ® Click the add button

Ll
[ Program Files +

File Name | Size | Update Date and Time
= aaa.ddw 10194  6/1/2010 6:17:18 PM
[ ab.ddw 40745 6/1/2010 6:27:24 PM
£ combine.ddw 3712404 4202010 3:03:38 PM

[£ reverse.ddw 3712404 4202010 3:19:54 PM I ‘

\"'Eﬁq | @ Click the remove button 2] |

@ Select the folder/file / Figure 7.7.2
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® Click the combine button on the tool bar, or select [Combine] from the [Tool] menu on the menu
bar to combine the data.

® Select combine

Combine

Figure 7.7.3
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8. ON/OFF Control
Operation status and settings can be changed by sending a command to indoor units. ON/OFF control

can be used when communicating with the outdoor unit.

8.1. Executing indoor unit test runs
Operation status and settings can be changed by sending a command to indoor units. To open the
ON/OFF controller window, select [ON/OFF control] from the [Action] menu.

Action | Help
I OMN/OFF control I

Figure 8.1.1

When the ON/OFF window opens, controls for operating the connected indoor units are displayed.

Unconnected indoor unit controls cannot be operated.

ﬂ Test operation ON/OFF controller EI
Cooling I Heating | Fan | Mode store | Mode re-store | Operation | Stop | Test operation |
No. 1 Net|51 No. 2 Netlﬂ Ne. 3 Net|53 No. 4 Net|55 No. 5 Net|54 Ne. & Net|56 No. 7 Ne‘tlﬁ_-"' No. 8 Net|53 Ne. 9 Met|5'9 No.].DNetIGG :
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il_l SEL SEL J_l SEL SEL SEL SEL J_l il_l SEL | oA SEL J_l
i“ﬁou'ﬁou 15= oumoumoumoumﬂmoumoum

OFF | TEST | OFF TEST | OFF TEST | OFF TEST | OFF TEST | QOFF TEST I COFF TEST | OFF | TEST | OFF TEST | OFF TEST |
Mo, 11 Net |61 Mo, 12 Met |61 Mo, 13 Net I Mo, 14 Net I Mo, 15 Nst I Mo, 16 Net I Mo, 17 Net I Mo, 18 Net I Mo, 19 Met I No. 20 Net I
&.0/High 1.7/High
Heat ON Heat ON
SEL | AIR | SEL J AIR | SEL J AIR | ZEL J AIR | SEL J AIR | SEL J AIR | SEL J AIR. | SEL | AIR | SEL J AIR | SEL J AIR |
ON || 3 ON i5 Z C'- i5 Z C'- is Z C'- 15 Z C'- I 3 || 3 I 153: o i5 Z
o | mer | | | e | o | wer | o | e [T | e | o | e | o | | Cor | e | o | |
No. 21 Met I No. 22 Met I No. 23 Net I No. 24 Net I No. 25 Net I No. 26 Net I No. 27 Net I No. 28 Net I No. 29 Met I No. 30 Net I

| | | | | | | | | |
SEL | AR | SEL | AR | SEL | AIR | SEL | AR | SEL I AR | SEL | AIR I SEL | AIR | SEL | AR | SEL | AIR | SEL | AIR |
oN || s on || s on || s on || s on || s on || s oow || s ow || 5= e | BEG== = | I T=
:==| TEST | off | TEST | off | TEST | off | TEsT | off | TEST | off | TEST | off | TEST | :==| TEST | off | TEST | off | TEST | il

Figure 8.1.2
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8.1.1.

Changing the operation mode for all units

The mode for all indoor units can be changed simultaneously. The mode for all units can be

simultaneously changed to 3 different modes - [Cooling], [Heating] and [Fan].
Click the [Cooling], [Heating] and [Fan] buttons to send a mode change command to all indoor units and

change the operating mode.

Change mode for all units buttons (Cooling, Heating and Fan)

ﬁvstopamnmﬁm B EoE x|
I Cooing Fas I Modestore | I Operation I Sop I Test operation ] I
ot =5l %z =T i =T wet =mlE s =l we =% w7 =[F % werT‘-:sne

E EAFIFIAEAEAFE3 /

Change operation status for all units buttons (Operate, Stop and Test operation) = _TJJ—:[_:I—:
ml =] =] = I_I ETI = || = | =] = illili]ilﬂ
w6 el e w: shet| mwne| wmnel e[ s mue=]
FIIE3 | |

= mle|ls|lew|=|l=]|=|=|=]|=]=] | =] =] =]
ijl == o || '—5::1_] ifz_ﬁ 5:1'_[ Sﬁ_‘zl S | _]r —3:'1_]{ #::_J = ol e |8
o e I I e e M e e e e e | |
ot 2= ‘-:::E—:VZZJ'E;_-"_: [ wsw] wowel waswe] wm3wel wmas=l
| | | | | | | |

| mlas|la|=|a|=s|a]| =] =] | =] | w| =] =]
_Jl == _J == _l ;::_l} == _[ 15— _I 5— _| 5~ __I[ :‘_J :_J o |
s =] | =] =] =] = s | =] = =] =] =] teee ] ] o] e | L

Figure 8.1.3

All units can also be simultaneously switched to Operate, Stop and Test Operation. Click the [Operate],

[Stop] and [Test

Operation] buttons to send a operation status change command to all indoor units and

change the operation status.

8.1.1.

Changing operation mode for individual units

Operation mode for each indoor unit can be changed individually by operating each unit's controls. Click

the select operation mode button (initially displayed as SEL) to switch between operation modes in the

following order:

[Cooling] = [Heating] = [Fan]. Click the [ON], [OFF] or [TEST] button to send a

command to the relevant unit to change to the chosen operation mode or status.
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Figure 8.1.4

8.2. Storing operation modes
Click the [Mode store] button to save the current indoor unit's operation mode. When the [Mode store]
button is clicked, the current indoor unit operation mode is saved. However, saved operation data is

erased if communication is halted.

#.] Test operation ON/OFF controller EI@
Cooling I Heating | Fan | Mode store Mode re-store | QOperation | Stop | Test operation |
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] e e g v
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Figure 8.2.1
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8.3. Restoring operation mode
Operation modes saved in Storing operation modes can be restored. Click the [Mode re-store] button to

restore the operation mode. When the [Mode re-store] button is clicked, a command to change to the
saved operation mode is sent to each unit.

Mode re-store

-quTnz [T ot [T mt elT e n]'_veu h{_hu ~I_nu (@ ey B cow® -
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o | wmfom| mr || || we| oo I_I_Jw wawal

[PESTR T TR T Glunul'_b.uml_vau\.-.l'_gu-[_-r-a-l—'eu-l_uuul_\-am[_
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o e e e e B B R
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Figure 8.3.1
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9. Creating test run reports

Data saved when communicating with outdoor units can be used to create test run reports. The created
data can also be used to print out test run reports.

9.1. Opening the test operation report window

Click the [Report for Test Operation] button on the main menu screen.

3 Welcome to SMMS- DYNA DOCTOR ==
DynaDoctorV Ver. 0360

SMMS-i super modular multi system

OutdoorUnit

MN-SWMS '
__| Report for test operation button |

Report fae Test
opeaton

Coparigra (0) 2018-2012 Toshba Carrier Corporation Al Reghts Fesarved

Figure 9.1.1

The report type selection window opens. Choose the data for the relevant outdoor unit from the list. Click
the [Start] button to open the report for test operation window.

(53 Report type selection o = esl]

The type of the report is selected.
MiMi-SMMS hd

Gneel_| |

%
Figure 9.1.2 \

Start button
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e o e
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Test Perscn st ;Y». test persaor =

Figure 9.1.3

9.2. Creating report data

Enter data into each field on the screen to create report data. The items which can be input are as follows:

Project/Site data

Item Method Note

Project/Site Entered by user Required

System name or No. Entered by user

Customer Entered by user

Date Selected by user

Test result file Selected by user Required

Customer Entered/Selected by user Required
Existing data can be selected from the
drop-down list

Div./Section (Customer data) Entered by user

Name (Customer data) Entered by user

E-mail (Customer data) Entered by user

Tel (Customer data) Entered by user

Address (Customer data) Entered by user

Company name Entered/Selected by user Required
Existing data can be selected from the
drop-down list

Div./Section (Test person name) | Entered by user

Name (Test person name) Entered by user
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ltem Method Note
E-mail (Test person name) Entered by user

Tel (Test person name) Entered by user

Address (Test person name) Entered by user

Test result Entered by user

Proposal Entered by user

Outdoor unit information

ltem Method Note
Installation location Entered by user

Breaker installation location Entered by user

No. of outdoor units Selected by user Required

Equipment name

Entered by user

Equipment number

Entered by user

Piping length

Entered by user

Additional amount of refrigerant

Entered by user

Item(s) to be checked

Entered/Selected by user

Required for items which can be
selected

Indoor unit information

ltem Method Note
No. of indoor units Entered by user Required
Pattern for each type Selected by user
Refrigerant name Selected by user
Date Selected by user
Inspector Entered by user
Breaker capacity Selected by user
Measured value or judgement Entered by user
Installation location Entered by user
Model Entered by user
Equipment number Entered by user
Item(s) to be checked Entered/Selected by user
Data attachments
ltem Method Note
Refrigerant cycle operation Selected by user Required

status

System data list

Selected by user

Indoor unit operation status

Selected by user

Outdoor unit operation graphs

Selected by user

System configuration diagram
(communication)

Selected by user

System configuration diagram
(refrigerant cycle)

Selected by user
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9.2.1. Specifying test result data
To specify test result data, click the [Search] button. A select file dialogue is displayed. Select the file to be

used to create the report.

When afile is selected, the file path appears in the test result file text box.

Test result file

File name Searc

Figure 9.2.1 Search button

9.2.2.  Creating customer/test person data

To create customer/test person data, choose [New customer data] from the drop down menu and enter
the data. To edit existing customer/test person data, choose the data to be edited from the drop down
menu and enter the data.

When report data is registered, the new customer/test person data is added or updated.

Customer data

CustomerList |H=_'.'. ustomer data j

Customer I

Div JfSection |

Nams |

E-mail I

Td |

Address Postode

Figure 9.2.2

9.2.3.  Entering test results/proposals
Enter test results data into the [Test Result] text box. Check the [Proposal] box to enter a proposal. Data
can then be entered into the [Proposal] text box.

If a proposal is entered, only 5 lines of test result data can be entered.
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Proposal check box Figure 9.2.3

Proposal text box

9.2.4.  Entering pipe lengths/additional amount of refrigerant
To enter the amount of added refrigerant and pipe lengths for the whole system, select the [Refrigeration
amount calculation] menu or click the [Refrigerant calculation] button. Click the [Refrigerant calculation]

button to open an additional refrigerant amount window.
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Modal rave il it 7o¢ lengtS(m) 0,60
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al Fmeurk S cadcd etz
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Inverter -
Check itoms Chek method Standad Unit A Unit B Unit O Unit D Judpe
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Figure 9.2.4
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In the calculator for additional refrigerant window, the outdoor unit model can be chosen, and pipe lengths
can be entered. The entered results are used to calculate the refrigerant pipe length and the amount of

additional refrigerant.

@ PR U @!.@
Gas amaent coovection (1adle 2 ) — Pocieng by Liquod resae (tadie )
'W—‘“Hﬁtﬂtt utdoar int comenTos g%)_ Lt poa sie | A48 E LI | ory iy
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1] 1P 83|’ 1273 { 2¥13) 0.30%
el &P (] 15505 1 818} 0,160
1 16HP o3| ¢ 19.1(3 / 4¥LS) 0.250
18 1040 B9 00l T 1 122217  #X18) 0,350
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220 1P| LD ] el
T A 43;
T 1s| T
—l 10WP] B e 40T
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10MP] LOVWP| 20| T
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36L 0K LORD] BHE] D 4@+’_‘_
1260] 139] 12 40
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el 12HF| 129| 1208] 100 00| I
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Figure 9.2.5

To calculate the refrigerant pipe length and the amount of additional refrigerant:

First, check the check box for the total capacity (hp) of the outdoor unit which executed test operation.
Next, enter the lengths of the connected pipes for each pipe diameter.

After entering the data, click the [Calculation start] button to calculate the refrigerant pipe length and the

amount of additional refrigerant. Click the [OK] button to save the calculated results.
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Figure 9.2.6

Click the [OK] button to close the calculator for additional refrigerant window, and automatically enter the

calculated results for the outdoor unit [Pipe length] and [Additional refrigerant amount].

Pipe length(m) 30.00
Additional
refrigerant amount 10.25

calculation

Figure 9.2.7

9.2.5. Checking the refrigerant amount calculation formula

Click the [Formula] button to check the formula for additional refrigerant amount calculation. The formula

for additional refrigerant amount window opens when the [Formula] button is clicked.

The formula for calculating the additional refrigerant amount can be checked in the formula for additional

refrigerant amount window. Click the [Back] button to return to the calculator for additional refrigerant

window.
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9.2.6. Automatically filling in test results
The test results for outdoor/indoor units can be filled in automatically. To automatically fill in results:
Outdoor units - click the [Auto fill to non measure item] button in the [Outdoor unit] tab.

Indoor units - click the [Auto fill to non measure item] button on the [Indoor unit] tab.

Auto fill to non measure item button
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Figure 9.2.11

If the number of outdoor/indoor units is below the maximum, a confirmation message appears. Click the

[OK] button to automatically fill in the test results.

Report for Test operation E

Fill all the combo-box with normal (OK or V),
and clear data from Mo. 2. Text unit data onwards.

Cancel

Figure 9.2.12

9.2.7. Importing screens

System status can be imported as a picture using the test result file data. Screens can be imported when
a test result file is saved.

Select the screen to be imported from the [Data selection] list displayed on screen. Then click the [Import]
button when it can be clicked.

55/67



TOSHIBA

fle  Testeepart  Befngersnt smount calculetion  Help
Fupenio Prajert/Ste Wyetem e T
Prowct/See dea | Test resut 1Ovtdoo) | Tagt reaut Dndood) Dgiey Dats attachmers
_ Deta selecvon - Gragh séle (Man 6]
§ frgarant cych grash Jrut e oY
F"Ismmamma ot I~ Jcomo W2 T [Como Mz
I Jidon opermon Wl r sensor I [Presure sensor
I Joutdosr cendeion Gaaph [t I |7d sarmor I |Té senser
r TEL/TEYTUTO r TELTEITUTS
I fponat ogram at o ok
[hea — ot [ [Ty sermor I |18 senser
™ Mv1/2 open st ™ [PMV1/2 cpen Gt
I [PNVS open rato I |PMV4 cpen rato
 [AEhRSVSYS) (= [Iw-vamisvaisvs)
s Ve V6
L
rm2345 I |m2345
i [
Data selection I joutdoo Fan mede [ |outdos fim mode
I~ [indoor signal
Falowenl unt Folower3 unt
™ Momp He I~ |Como wr
I~ [$reswre sensor ™ [Presswre semsor
I IT0 senson [T [T senser
- TEL/TEYTUTO r TETR/TYTO
2 ns0r ansor
T [Ty sermor ™ | Tssensoe
™ NYL2 open mto ™ |PHY1R tpn it
I~ BN open o ™ |PHV4 cpen o
r HWVIWSVRISVS r AWVl SV SV
Ve V0
w2345 M |m™z345
T Nutgotr Fan mode ™ |Gutdosr Fam made

The wait screen is displayed while the screen is rendering. When it has been rendered, the selected

screen is displayed.

The [Record No.] and scroll bar for browsing data appear on the import screen. Display the data to be

imported, and select the [Retrieve] menu to import the screen data. Click the [Preview] button to check the

imported screen data.

Figure 9.2.13
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To import a screen from the [Outdoor unit operation graph list], graph items must be selected. If an
attempt to import the [Outdoor unit operation graph list] is made without any graph items selected, an
error message is displayed.

9.2.8.

Select [Registration/modify] from the [Test report] menu to register entered report data. To register new

data, select [New report] from the [Test report] menu and allocate a [Report No.]. Then select

Report for Test operation E

ii Select the Graph to display

Figure 9.2.16
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Jort for Test operation sort for Test operation
Tepor‘c‘ Refrigerant amount Testreport | Refrigerant amount
t| New report | 1 New report
Registration / modify | Registration / modify |
Retrieval / delete L Retrieval / delete L
ProTerfrsEE T DrATerF o T
Figure 9.2.18 Figure 9.2.19

When [Registration/modify] is clicked a register/modify report data message is displayed. Click [OK] to
start registering the report data to the database file. If the report data is registered correctly, a registration

complete message is displayed.

Report for Test operation @

:I Do you want to replace the file with current content?

OK E—

Figure 9.2.20

-

Report for Test operation @

Figure 9.2.21

If a test data file which has already been registered is registered again, a test results data confirmation

message is displayed.

Report for Test operation @

Same file name exist on BackUp file. [
! & ChUsers\User\Documents\Toshiba Carrier Corporation\DynaDoctor
Multi\testfile ]
If want to save current data, change file name
and retrieve again.
If you want to replace it, push [ OK]

Figure 9.2.22
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9.3. Searching for report data
Registered report data can be searched. Select [Retrieval/delete] from the [Test report] menu to open the
test report retrieve window.

Testreport | Refrigerant amount
t Mew report
Registration / modify
| Retrieval / delete |

Fronertisite oS

Figure 9.3.1

In the test report retrieve window, search conditions can be set and relevant report data can be retrieved.

The following conditions can be set for searches:

ltem Method Note
Report No. Entered by user

Project/site name Entered by user

Start date for test Selected by user

Customer name Entered by user

If no search conditions are set, all of the registered report data will be shown in the search results.

20 rot remaEber 1200 Na,, 3i5 Ok SSERCH with dlaok.

I AND sesrs 1 O pench

il | wordey . Cemete 12 W | e Cecmom 8 2]

© ANT sawrk 7 M gsarrh

r - [

Figure 9.3.2
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Searching by Report No.
Click the radio button next to [Report No.] to select a report no. to search for. Report numbers can be

entered when the [Report No.] radio button is selected.

To specify the report numbers to search for, enter numbers in the text boxes next to [Report No.] and [To].

If the starting report no. or finishing report no. is unclear, leave the box blank.

+ Report No.

Report No. 1 To l.di

If do not remember report No., pls click SEARCH wiith blank.

Figure 9.3.3

Click the [Search] button to search for report data with the specified report no.

Reoart Mo, Maport tyoe  Systern name of 0 Project/Ske name | Custormes same  Start date for test  Fot dats - |
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Search button
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r | —
" 200 sewch ' OR seerch
= | Wontay | Desster 3 =] T | bordey | Desssbe 3 <) ]

I AMD sseeh ' OR Sas)

o |

Figure 9.3.4

If report data is found which fits the set conditions, it is displayed on screen. To display the contents of the
report data, select the data and click the [Select] button.

A confirmation message is displayed before the data is displayed. If the currently entered data does not
need to be registered, click the [OK] button.

The selected report data is displayed when the [OK] button is clicked.
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Figure 9.3.5

Cancel |

9.3.2.

Figure 9.3.6

Searching by project/site name, test start date and customer name

To select and search for project/site name, the test start date or customer name, click the radio button

next to [Other]. When the [Other] radio button is selected, project/site name, the test start date and

customer name can be entered.

To search for a project/site name, check the [Project/Site name] check box. When [Project/Site name] is

checked, data can then be entered into [Project/Site name].

Check [Start date for test] to set a test start date to search for. Check [Customer name] to set a customer

name to search for.
w e
W Progect Ste naeve
¥ Stant gatetortest

W Camane rand

= AND sewcs 7 OR waarcy

[ Wondsy . Cecander 1ol e | wondey | Decsster 1]

= AND sawch © OR saarch

Figure 9.3.7
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When several search items have been entered, AND search or OR search can be selected. If the AND
search is checked, report data which matches both conditions will be searched for. If the OR search is

checked, report data which matches one or more of the conditions will be searched for.

For example, if information is entered as below, report data in which the project/site name is "Air
Conditioning System" and the start date is "February 2nd 2011", or the customer name is "Toshiba", will

be searched for.

& Obrer
W ProgeesSte neve [um'\gymm
= AXD sswct (" OR swarch

P it sate fartast | Mondsy | Decanber v w) e | ordew | Decenber » v|
™ AND sawcs 7 OR sserch

W Comsre reme [rm-
Figure 9.3.8

9.4. Deleting report data

Registered report data can be deleted. To erase report data, select the report data to be deleted and click
the [Delete] button.

SNMS4 Toshbs IL/IV2012 123:20:01 AM 11192012
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Figure 9.4.1

A delete confirmation message is displayed. Click the [OK] button to delete the data. Clicking the [OK]
button deletes the report data from the database file.
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Test report retrieve @

:I Do you want to delete all selected report data ?

Cancel

Figure 9.4.2

9.5. Printing out report data

Report data can be printed out. To print report data, select [Print...] from the [File] menu.

&, Report for Test o)

File | Testreport

| Brint | ;

Exit i

Figure 9.5.1

A start printing confirmation message is displayed. Click [OK] to start printing. The test operation report

printing screen is displayed when the [OK] button is clicked.

Report for Test operation @

Cancel

Figure 9.5.2
On the print screen, the printer settings, number of copies and printing format can be set.

Click the [Property] button to change the printer settings. A print dialogue is displayed. The number of

copies can also be input directly.
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No. of copies

Microsoft XPS Document Writer

Property button

Prist style
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Figure 9.5.3 \_
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Figure 9.5.4

Click the [OK] button to print the test operation report.
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10. TOSHIBA CARRIER SOFTWARE LICENSE AGREEMENT

IMPORTANT: PLEASE READ TERMS AND CONDITIONS OF THIS AGREEMENT CAREFULLY
BEFORE USING “DynaDoctor for VRF SOFTWARE” (HEREINAFTER CALLED “THE SOFTWARE”).
BY USING OR INSTALLING A WHOLE OR A PART OF THIS SOFTWARE, YOU (HEREINAFTER
CALLED “USER”) ARE DEEMED TO ACCEPT ALL THE TERMS AND CONDITIONS OF THIS
AGREEMENT. IF USER DO NOT AGREE TO THESE TERMS AND CONDITIONS, DO NOT USE OR
INSTALL THE SOFTWARE AND RETURN TO THE LOCATION FROM WHITCH IT WAS OBTAINED.

1. For the purpose of this Agreement, "Software” means the computer programs and information and
data (including without limitation electric documents) contained in the media or files distributed with
this Agreement., except those specifically excluded not as a part of the software in writing.

2. The Software is the property of Toshiba Carrier Corporation. Toshiba Carrier Corporation owns all
intellectual properties in the software. User may use the Software only in accordance with the terms
and conditions of this Agreement, and only for such purpose as designated by Toshiba Carrier
Corporation or as agreed to by Toshiba Carrier Corporation.

3. Toshiba Carrier Corporation owns the copyright of the software and data in the software. The
software is protected under applicable copyright law and international conventions.

4. User may copy and install this Software for such purpose as described in the documents of the

Software. Any copy created by User shall be immediately destroyed immediately after necessity of

such copy are ended. With an exception of the forgoing, User shall not make any copy of the

Software;

User shall not reverse engineer, decompile, disassemble, or modify the Software.

User shall not use the software with plural people within any internal network or Internet.

User shall not distribute, transfer, rent, lease, or sell its right to use the Software to anyone.

© N o o

User shall respect the intellectual property right of the software. User understand the confidential
nature of the Software and agrees to safeguard the software from disclosure to any third party.
9. User shall comply with the Foreign Exchange and Foreign Trade Control Laws and other related
export regulations applicable in Japan. User shall comply with the U.S Export Administration

Regulations, export control laws and regulations of all other countries.
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12.
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THIS SOFTWARE ARE PROVIDED “AS I1IS” WITHOUT ANY WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTY AND
FITNESS FOR A PARTICULAR PURPOSE. TOSHIBA CARRIER CORPORATION HEREBY
DISCLAIMS ANY WARRANTIES RELATING TO QUALITY AND PERFORMANCE OF THE
SOFTWARE. TOSHIBA CARRIER CORPORATION SHALL NOT BE LIABLE FOR ANY DAMAGES,
LOSSES, EXPENSES OR COSTS, IF ANY, INCURRED IN CONNECTION WITH OR AS A RESULT
OF THE USE OF THE SOFTWARE.

Toshiba Carrier Corporation reserve a right to make modification or improvement of the software at
any time.

In the case of breach any terms and conditions of this Agreement, or this Agreement be terminated or
expired, User shall de-install the Software, scrap the Software any/or return the media and/or the files
of Software to Toshiba Carrier Corporation immediately, along with any remaining copies thereof.
Toshiba Carrier Corporation may request User to stop using the Software at any time upon notice to
USER.

. This Agreement are governed and construed by the laws of Japan.
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